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Intro duction  

This is a technical manual, designed as a reference to supplement other Q documentation.  It 

does not contain detail on many many key procedures in Q.   

Ý TIP:  The easiest ways to learn how to use Q is to read the Q Quick Start Guide, or, to 

complete the online training (click on Help and Online Training).  ). 

This manual is split into the following parts:  

Ý Formatting outputs describes the various methods for controlling the appearance of 

tables and graphs within Q and when exported to other programs.  

Ý Tests of statistical significance describes the theory and practice of Qôs different types 

of statistical tests. 

Ý Data file specifications describes how to set up data files and deal with data files in Q.   

Ý Manipulating questions*  provides detailed explanations of the various ways that 

questions can be defined and modified. 

Ý Variables*  discusses the detail of constructing new variables.  It focuses on 

complicated transformations of data.   

Ý Coding text data*  describes how to code text data in Q. 

Ý Multivariate analysis*  describes how to conduct latent class analysis, tree-based 

models, cluster analysis, principal components analysis, regression and 

correspondence analysis in Q. 

Ý Using R*  explains how to use Q with R.  R is the worldôs leading software for super-

advanced statistics. 

Ý Tips, tricks and troubleshooting outlines some of the more common issues that users 

have with Q. 

* Only applicable for users of Q Professional. 

TIP:  The quickest way to find something out is to click on the Help menu and select Online 

Documentation Search.  This takes you to a web page where you can search through Qôs 

documentation. 
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Overview  

Q provides a multitude of different ways of formatting outputs, from the creation of maps in 

PowerPoint through to exporting raw data in Excel.  This part of the manual focuses on some 

specific tools for formatting outputs.  The Q Quick Start Guide should be consulted for a more 

general overview. 

The appearance of a table can be modified by: 

Ý Directly manipulating the table.  For example, merging categories or pressing the 

various toolbar buttons.  These are described in the Q Quick Start Guide. 

Ý Right-mouse-clicking on one or more tables and selecting options from the context 

menu.  The options shown depend upon the table being viewed.  The statistics 

available from Statistics ï Cells, Statistics ï Below and Statistics ï Right are 

described on page 2213 and following.  The remaining options from the context menu 

are described in the Q Quick Start Guide, which describes the various settings that can 

be applied to an individual table.  

Ý Table Options shows more detailed settings that can be applied to one or more tables 

(page 13 and following).  

Ý Project Options describes the settings that can be applied to the project as a whole  

(page 22 and following).  

Ý User Options lists the options that can  be set which are remembered whenever the 

user is running Q (page 25). 
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Statistics  

Different statistics can be displayed on a table by selecting the following from Statistics ï 

Cells, Statistics ï Right and Statistics ï Below, which are all accessible by right-clicking on 

a table.  The statistics that are available depend upon the questions shown in the table. 

% The weighted proportion of respondents to give a particular response.  

This is computed as Population / Base Population. Note that in some 

other programs, such as SPSS Custom Tables 19, a different 

computation is used, whereby the percentage is only computed for 

respondents that have provided data; thus in Q it is possible to have a 

NET which is less than 100% (which indicates some people have not 

selected anything) while in the other programs the NET, which is often 

labeled as Total, always shows 100%). 

% Row Share The proportion of the total Sum for the row of the table represented by 

the cell. 

% Column 

Share 

The proportion of the total Sum for the column of the table represented 

by the cell.   

% Share 

  

The proportion of the total Sum for the table represented by the Sum 

cell in a margin of the table (obtained via Statistics ï Right or 

Statistics ï Below).  If you delete some categories in a table, but leave 

these categories in the NET, the share shown in the NET may exceed 

100%. 

% Total Share The proportion of the total Sum for the table represented by the cell.  

5th Percentile The value which 5% of non -missing observations are equal to or below. 

25th Percentile The value which 25% of non -missing observations are equal to or 

below. 

75th Percentile The value which 75% of non -missing observations are equal to or 

below. 

95th Percentile The value which 95% of non -missing observations are equal to or 

below. 
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Average The weighted mean, which is defined as Sum / Population. 

Base n The total unweighted sample size that is used to construct the cell in the 

table.  That is, the total number of observations with non -missing values 

in the data used to create the row and the column of the cel l.   

Base Population The estimated number of people in the total population from which the 

data is derived.  It is the weighted total sample size (i.e., Base n).  

Unless different sample sizes apply to different cells in the table, such as 

with a split cell experimental design, the Base Population will be the 

same for all cells in the table.   Where a Date question is used, Base 

Population only relates to the individual time period.  

Coefficient The coefficient in an Experiment or Ranking question. 

Column % The weighted proportion of respondents in a column to give a particular 

response.  Note that in some other programs, such as SPSS Custom 

Tables 19, a different computation is used, whereby the percentage is 

only computed for respondents that have provided data; thus in Q it is 

possible to have a NET which is less than 100% (which indicates some 

people have not selected anything) while in the other programs the 

NET, which is often labeled as Total, always shows 100%). 

Column n The number of observations containing data in the column. For 

example, if the column represents males, then the Column n is the 

number of males in the sample that do not have missing data on the 

row variables.  Note that this definition means that if you change a Pick 

Any question to a Number ï Multi question, this will cause the Column 

n to change (and become equivalent to the Base n). 

Correlation Pearsonôs Product Moment Correlation.  A value of 0 indicates no 

statistical association.  A positive number indicates a positive association 

ï as one goes up the other, on average, also goes up, and vice versa for 

negative values.  The further a correlation from 0, the stronger the 

relationship. 

d.f.  Degrees of freedom. 

Effective n Equivalent to n, except adjusted to reflect the effective sample size. 
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Effective Base n Equivalent to Column n, except adjusted to reflect the effective sample 

size. 

Effective Row n Equivalent to Row n, except adjusted to reflect the effective sample 

size. 

Effective 

Column n 

Equivalent to Base n, except adjusted to reflect the effective sample 

size. 

Expected The expected value of the statistic under the assumption of 

independence. The statistic the Expected refers to is sometimes a 

percentage, sometimes an expected average and sometimes an 

expected value of Population.  With two dimensional questions, the 

value of Expected is a rough approximation (the correct statistic takes 

a few hours to compute).  This depends on the table.  

Interquartile 

Range 

The difference between the 75 th and 25th percentiles. 

Labels The labels assigned to specific values of categorical variables.  For 

example, ñGenderò may be associated with the value ñ1ò.  Only available 

when RAW DATA is selected in the brown drop-down. 

Maximum The highest value of a respondent. 

Median The value which 50% of non -missing observations are equal to or 

below.  This definition is different to that employed in some other 

statistics and market research programs. 

Minimum The lowest value of a respondent. 

Missing n The total number of observations in the database, less Base n, filtered 

observations and deleted observations. 

Mode The most commonly occurring non-missing value. Where there is a tie, 

the lowest value is selected. 

n The number of people in the data file in the cell in the table.  This is 

commonly referred to as a count.  When the table involves numeric 

data, n is the sample size used to compute the average or correlation. 

Not duplicate A 1 indicates that the cell is not ñoverlappingò with another cell and a 0 
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indicates that it overlaps. For example, if a table contains ñ18 to 24ò, 

ñ25 to 24ò and ñ18 to 34ò then the ñ18 to 34ò cells will have a value of 

0. This is used in the computation of multiple comparison adjustments 

(i.e., if a cell overlaps other cells, it is not used when computing cutoff 

values for computation of tests of statistical significance).  

p 

 

 

The p-value for the cell.  This has been adjusted to reflect the settings 

in Sample scaling constant (see the Q Quick Start Guide), but does 

not take into account the Multiple comparisons method (see page 

47), which means that a cell may not be highlighted as being statistically 

significant even if the p-value is less than or equal to the specified 

Significance level (which is, by default, 0.05).  

Population The estimated number of people in the population (as determined from 

the weight) in the cell in the table.  When the table is showing 

categorical data (i.e., Pick One ï Multi, Pick Any, Pick One and Pick 

Any ï Grid), the Population is a weighted count (i.e., the weighted n).  

When the table involves numeric data, Population is the estimate of 

the number of people in the population to which the average or 

correlation applies. 

Probability % Ranking questions display a Probability % which is an estimate of the 

proportion of the population that would choose an option first (i.e., with 

the highest ranking) , under the assumption that everybody in the 

population has the same underlying ranking (i.e., that the difference 

between people reflect random noise).  This statistic is not computed by 

counting up the proportion to give an option the highest rank; rather, it 

is derived from Coefficient (via a logit transformation) and takes into 

account all the ranking information across the sample.
1
  In general, 

Probability % has a lower sampling error than will be computed if 

counting up the proportion to choose a particular option once and can 

thus be a more reliable statistic for assessing preferences. 

Row % The weighted proportion of respondents in a row to give a particular 

response.  Note that in some other programs, such as SPSS Custom 

                                           

1
 See Allison, P. D. and N. A. Christakis (1994). "Logit Models for Sets of Ranked Items." Sociological 
Methodology 24: 199-228. 
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Tables 19, a different computation is used, whereby the percent age is 

only computed for respondents that have provided data; thus in Q it is 

possible to have a NET which is less than 100% (which indicates some 

people have not selected anything) while in the other programs the 

NET, which is often labeled as Total, always shows 100%). 

Row n The number of observations containing data in the row. Respondents 

who have either not selected any of the options in the columns of the 

brown drop-down question, or, have missing data in one or more of the 

cells of the row, are not counted.  

Standard 

Deviation 

A measure of central tendency. 

Standard Error The standard deviation of the sampling distribution .  Where the data is 

numeric, this is computed for the Average, where it is an Experiment 

or Ranking, it is computed for the Coefficient and where it is a 

proportion, it is computed for the Total % (note: whereas the total % is 

multiplied by 100, the standard error is not , and, the denominator i s 

equivalent to the Effective Base n), except for with Pick One ï Multi 

questions in which case the proportion is whichever is applicable of a 

Row % and Column %. 

Column s.e. The standard error of the Column %. 

Sum The weighted sum of all the responses, defined as Average multiplied 

by Population. 

Text The raw data from Text Variables (e.g., verbatim responses from open-

ended questions). 

Total % The weighted proportion of respondents to give a particular response. 

This is computed as Population /  Base Population. 

Trimmed 

Average 

The average computed after deleting the lowest 5% and highest 5% of 

non-missing values. 

t-Statistic Coefficient divided by the Standard Error, except for Ranking 

questions where the t-statistic is computed using the Probability % and 

the standard error for this computation is not shown.  
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Values The values of the variable(s) in a question (e.g., a ñ1ò may represent 

men).  Only available when RAW DATA is selected in the brown drop-

down. 

z-Statistic The value from the standard normal distribution w hich corresponds to 

the two-tailed value of p.  The further this value is from 0, the more 

statistically significant the difference between the observed data and the 

Expected data, where 1.96 and -1.96 each equate to p being 0.05. 



Q REFERENCE MANUAL    FORMATTING OUTPUTS : TABLE OPTIONS  

      
 

Page 19  

Table O ptions  

Table options are settings that are related to the table currently being edited.  They are 

accessible from the Edit menu by right -clicking on a table and selecting Table Optionsé. 

They are also shown when exporting to Microsoft Office (see the Q Quick Start Guide). 

If you select multiple tables in the Report tree then any changes to Table Options will apply 

to all of the selected tables.   

The Table Options dialog box contains five tabs: Exporting, Styles, Decimal Places and 

Footer. 

 

Figure 1.  Table Options 

Exporting  

Format determines how the table is to be exported (as a chart or a 

table), the application and the charting format (e.g., To PowerPoint as Microsoft Graph).  

More detail is provided in the Q Quick Start Guide. 

Chart dictates the type of chart (bar, pie,  etc.) to be created, if exporting  

a chart. 

Office Exporting  

Chart  
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The Notes field can be used for making notes about the table.  When 

exporting, these notes are included in the notes field in PowerPoint, as a comment in Excel 

and as a paragraph in Word. 

When Ignore NET and SUM is checked, the NET or SUM fields of the 

table are not exported.  

Styles  

Q permits the user to customize the appearance of tables by defining styles and determining 

which tables are shown with which style.  The setting of styles is described on page 22 and 

following.  While in general it is best to set a default style, in Table Options you can over-

ride these defaults and change the style of a particular table.  For each table, you can set a 

style for how it is shown on the screen, how it appears when printed, how it appears when 

exported as a PDF and how it appears when exported to Microsoft Office as a table.  Many of 

the formatting options only appear when tables are exported and may not appear to have 

changed when shown on the screen. 

Decimal Places  

The Decimal Places are the number of decimal places on display for numbers in the table.  

By default, they are blank and the number of decimals is taken from Project Options. 

Footer  

The Footer tab governs how filters and weights are displayed when exported (a preview  is 

shown at the bottom).  Anything shown in the triangular brackets is calculated by Q for each 

table.  For example, in  base n = <n> , <n> is replaced by the sample size when the table is 

exported or printed.   You can edit the various components of the footer.  For example, we 

could replace base n = <n>  with Sample Size is <n> people . 

To find out about the meaning of the various things available in the footer, please review 

Help4Q Help and the Q Quick Start Guide. 

When editing footers it is important to remember that:  

Ý The edit will apply to all tables that are selected.  This means that if you click on a 

single table and make changes, these changes will not be applied to all the other 

tables in the project.  

Notes  

Ignore NET and 

SUM  
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Ý If you rem ove the triangular brackets nothing is calculated and your footer may be 

incorrect.  For example, you replaced effective sample size  = <ess> 

(<ess%>)  with ESS is 923 , this would be incorrect if you applied a different filter 

or weight to the table.  
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Project Options  

Project options apply to the current project and are not remembered when opening other 

projects.  The project options can be viewed and edited by selecting Edit 4 Project 

Optionsé.  They can be restored to their defaults by pressing Restore. 

The different options are contained in a series of tabs: Table Styles, Printed Headings, 

Printed Cover Page, Printed Header/Footer, PowerPoint Export Layout, Decimal Places, 

Dates and Statistical Assumptions. 

Table Styles  

Table Styles allow the user to customize the look and feel of tables. Two styles are already 

set up in Q ï Colorful and Sobre.  Click  to add a new style (which commences as a copy 

of the style selected at the time).  Styles can be saved for reuse in other projects by clicking  

.  Saved styles can be imported into a project by clicking  . 

Various formatting options are presented in a series of checkboxes below the Fonts and 

Preview panes (see Figure 2).  They are designed to be self-explanatory and the effect of 

most of them can be seen in the Preview pane by (un)ticking the checkbox.  

To customize the font, font size or color used in a style , click on any of 

Table Heading, Statistical series, Column, Row, Data and Footer (see the section of 

Figure 2 enclosed with the dashed line) and choose the preferred settings. 

Set default styles for viewing on the screen ( Screen/Tables tab), Print, 

PDF and for when Export to Office as Table.  These defaults can be over-ridden for 

individual tables (see Styles, page 20).  The various approaches for changing the default 

appearance of graphs in Excel, Word and PowerPoint are described in Creating Templates, 

page 26 and following).  

 

Font s 

Default style  
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Figure 2.  Table Styles 

Printed Headings  

This tab allows you to set fonts and font sizes for headings and tables of contents in printed 

tables and PDFs.  Click on the section of interest and a dialog box will display the various 

formatting options.  

Printed Cover Page  

Create a cover page in another Microsoft Office application (e.g., Word or PowerPoint) and 

paste it into this text box.  

Printed Header/Footer  

This text will appear at the top and bottom of all pages when printing or exporting as PDF.  
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PowerPoint Export  

This tab contains self-explanatory settings for exporting to PowerPoint.  To set font formats, 

click on the text called PowerPoint Title  and the text of the footer to modify the format 

of the text.  To over -ride your PowerPoint fileôs Master Slide settings for the title you need to 

check Override font for PowerPoint title. 

Other options for exporting to PowerPoint are covered in the Q Quick Start Guide and in 

Office Exporting on page 19 of this manual. 

Decimal Places  

This shows the default settings for the number of decimal places for the various statistics in 

the project.  They can be overridden for a specific table ï see Decimal Places on page 20. 

Dates  

The setting for the way the date will be displayed in the project.  
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User Options  

User Options are user-specific settings saved on your computer which apply to all tables and 

projects when being viewed on the computer where the user options have been set . 

Display/Printing  

How to display variables in lists determines whether variables are represented by just their 

label (e.g., Age) or by their name and label (e.g., Q4: A ge).  Similarly, How to display 

questions in lists dictates whether questions are represented by the Question text or by 

variable names (for multiple response questions, Q uses the common aspects of variablesô 

names to deduce a single name). View PDFs after exporting determines whether or not Q 

asks the user if they wish their PDF to be viewed after exporting.   

When the Shrink tables to fit in the maximum size checkbox is ticked, tables exported in 

these two ways will be shrunk such that the entire table fits within the maximum size settings 

on a single page. If unchecked, tables may be wrapped across two or more pages to fit within 

the maximum size per page.    

Export Chart Defaults  

The default chart types for export can be customized by selecting the Export Chart Defaults 

tab in Edit4User Optionsé  The default chart types are based on the types of questions 

chosen in the blue and brown drop-downs.  They can be set using the grid of drop -down 

menus on the Export Chart Defaults tab.  These can be over-ridden using the Table 

Options (see the Q Quick Start Guide and Office Exporting, page 19).  The list of available 

chart types in the drop-down menus contains the standard Office chart types. This list can be 

augmented with template chart types created by the user , so that commonly u sed charts 

need only be formatted once (e.g., font colors, fonts, backgrounds).  See Creating Templates 

(page 26) for information on creating templates.  

There are three template systems: Microsoft Graph, Microsoft Excel (Office 2003 and 

earlier) and Microsoft Office 2007 (and later). 

Microsoft Graph templates are made available by setting the template system to Microsoft 

Graph and then entering the names of the te mplates into the templates panel.  To apply a 

Microsoft Graph template, select the table in the report that is to be exported as a chart 

with the same format as the template. Click the export button, select To PowerPoint as 
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Microsoft Graph or To Word as Microsoft Graph from the Format menu, and select the 

name of the template you want to apply to the chart from the Chart menu. Click OK. 

Microsoft Excel (Office 2003 and earlier) templates are included by setting the template 

system to Microsoft Excel (Office 2003 and earlier) and then entering the file name that 

contains the template charts into the Excel chart template box. The file name must include 

the full path name of the file.  

Similarly, Microsoft Office 2007 (and later) templates are included by setting the template 

system to Microsoft Office 2007 (and later) and then entering the file name that contains 

the template charts into the Template directory. Usually this will be automatically identified 

by Q. 

 

Creating  Templates  

When creating templates you can customize chart colors, fonts, and backgrounds for series, 

legends, and axes.  If doing this, avoid customizing individual data points, axis minima and 

maxima, or adding text , as these wonôt properly match other charts you will export.  If you 

customize series, then you should include at least as many series in your template chart as 

may appear in your real charts.  Otherwise, Office will revert to defaults for any extra 

information.  
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A way to create a template is to export a chart of the same type from Q, format it as des ired, 

then save it as a template.  

In Excel, create charts either from scratch or by exporting from Q.  Ensure 

that the charts are created as new sheets in the Excel file, rather than a s 

objects in sheets with other information in them.  Customize these as 

desired.  Save the Excel file as a normal Excel file (with extension .xls).  In Q, go to the Edit 

menu and select User Optionsé.  Select Microsoft Excel (Office 2003 and earlier) in the 

Template system menu, and then browse for your newly created Excel file in the Excel 

chart template box.  Browsing ensures that the full path name of this file is included in the 

Excel chart template box. 

Office 2007 (Vista) treats templates in a different way to earlier versions 

of Microsoft Office.  To create a chart template in PowerPoint 2007 (or 

Excel or Word), first create a chart either by exporting one from Q (using one of To 

PowerPoint as Excel Chart, To Excel with Chart, or To Word as Excel Chart) or by 

selecting Insert4Chart in PowerPoint.  Customize the chart as desired, then save it as a 

template. 

Tip : Consult the Q Quick Start Guide for more detail on exporting and select Help and Online 

Documentation Search for more information on working with templates.  
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TESTS OF STATISTICAL  SIGNIFICANCE  
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Overview  

Most uses of Q involve the analysis of survey data.  Surveys typically involve collecting data 

from a subset of the total population (e.g., even though there are 300 million Americans, you 

might only interview 200).  One of the challenges of analyzing survey data is trying to 

generalize results in the sample to the population (e.g., working out which conclusions 

relating to a sample of 200 people are likely to reflect the opinions of all Americans and which 

are not).  Statisticians have developed a variety of rules of thumb to help dis tinguish between 

results that are reflective of the population and result s that are not.  These rules of thumb are 

known variously as ñtests of statistical significanceò, ñhypothesis testsò and ñsignificance 

testsò. 

The chapters in this part of the manual describe the key aspects of how Q tests for statistical 

significance: 

Ý Automatic tests of statistical significance describes how Q determines which cells on a 

table to shade as being statistically significant.   

Ý Column comparisons describes how to conduct pairwise testing between different 

columns of a table. 

Ý Planned tests describes how to conduct significant tests on selected cells in a table. 

Ý Weights and effective sample size describes how Q addresses weights when testing for 

statistical significance. 

Ý Statistical testing options describes the options in Q that can be used to modify how 

tests are performed.  

Ý Technical details about the tests provides additional technical information about the 

significance testing methods in Q. 

 
















































































































































































































































































































































































































































































































































































